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Autodesk Fusion 360 Training



We need to thank our FIRST sponsor -







Proof of eligibility is required and may take up to 7 days to be 
processed. Documentation must include your full legal name, 
school name and location, and be dated for the current school 
term. See examples given below. (Image is from video linked on 
previous slide.)





You should have already downloaded and installed Fusion 360 
and downloaded the KoP STEP files. If you haven’t please see 
the email previously sent with details.

Open the software. You may be prompted to sign into Autodesk.

Click on New Project and name it “FreightFrenzy”.



Your screen should look similar to the one shown below.



Let’s get started

1 – Upload the STEP files into the project by clicking on the 
Upload button.
2 – Click on Select Files and choose the STEP files to add. File 
names will appear in the list and then click on Upload.



Let’s get started

3 – Files will begin to load in the Data Panel on the left side of 
the display. Click the Close button when the upload is complete.



Add Component

4 – Save your project by clicking on the Save Icon or by selecting 
Save from the File Menu in the Application Toolbar. Name the 
file “Chassis”.
5 – Using the Magnifying Glass Icon on the Data Panel, search 
for ”Tetrix_39069”.
6 – Left click and drag the Channel into the Workspace.



Orient Channel

7 – Using the Rotation Handles, orient the Channel as shown 
below (-180 degrees). You can also manually type an angle into 
the Entry Box. Click OK when finished.



Add Second Component

8 – Drag a second piece of Channel into the Workspace and use 
the Translate Handles to separate the two Channels.



Orient Second Channel

9 – Use the Rotational Handles to rotate the Channel to be 
perpendicular to the first (-90 degrees).



Orient Second Channel

9 – Use the Rotational Handles again to roll the Channel onto 
its side (-90 degrees). Click OK when finished.



Create Rigid Joint

10 – Create a Rigid Joint between the two pieces of Channel. To 
do this, select the Joint Command in the Assembly Menu (Shift 
+ J). The Joint Window will be displayed.



Create Rigid Joint

11 – Component 1 is the piece that will be moved and 
Component 2 is the stationary component. Using the 
Navigation & Display Toolbar at the bottom of the worskspace, 
rotate the workspace to view the bottom of the second Channel
you added to the project. From left to right the identified tools 
below are the Orbit Tool, Pan Tool, Zoom and Fit Tools. You can 
also use the Mouse Scroll Wheel (if you have one) or the View 
Cube in the upper right corner. Also, use the Esc Key to end the 
commands when finished.



Create Rigid Joint

12 – Select the large outside circle as the first piece of the Rigid 
Joint.



Create Rigid Joint

13 – Orient the workspace to see the large outside hole on the 
first Channel added to the project and select it as the second 
piece of the Ridged Joint.



Create Rigid Joint

14 – Component 1 should move into position with Component 2. 
Click OK when finished.



Create Rigid Joint

15 – Use the Home Icon in the View Cube to reset the 
workspace. You should see a Rigid Joint Mark between the two 
pieces.



Finish Chassis Frame

16 – Using previous concepts, add two additional Channels and 
create Rigid Joints to complete the Frame. 



Wheel Assemblies

17 – Using the Magnifying Glass Icon on the Data Panel, search 
for ”Tetrix_39055”.
18 – Left click and drag the Wheel into the workspace.



Wheel Assemblies

19 – Using the Rotation & Translate Handles, orient the wheel 
as shown below. Click OK when finished.



Wheel Assemblies

20 – Using the Magnifying Glass Icon on the Data Panel, search 
for the following and drag the needed amount of parts into the 
workspace.
(1) Tetrix_39088, 80mm X 4.7mm Axle
(2) Tetrix_39091, 11mm X 4.75mm Bushings
(1) Tetrix_39086, 80T Gear
(2) Tetrix_39172_Collar, 4.7mm Locking Collars



Wheel Locking Collar

21 – Attach a Locking Collar to the Wheel. Create a Rigid Joint 
between the outside of the Locking Collar Hub and the center 
circle of the Wheel. 



Wheel Locking Collar

22 – The Locking Collar will probably be on the wrong side of 
the Wheel surface. Select Flip in the Joint Window to get the 
collar in the correct orientation. Click OK when finished.



Wheel Axel Bushings

23 – Install the brass Axle Bushings into the fifth large hole from 
the end on both sides of the channel as shown using Rigid 
Joints.



Gear Locking Collar

24 – Install the Locking Collar on the Gear using a Rigid Joint as 
shown.



Insert Axle Through Channel

25 – Insert the Axle through the Bushings using a Revolute Joint
as shown below. Make sure to select the outside of the Axle and 
the inside of the Bushing.



Insert Axle Through Channel

26 – Use the Translate Handles to draw the Axle out of the 
Bushing (-1.50).
27 – Change the Joint Type from Rigid to Revolute by selecting 
the Motion Tab in the Joint Window. You should see the Axle
Animate and spin inside the Bushing. Click OK when finished.



Wheel & Axle

25 – Attach the Wheel to the Axle using a Rigid Joint. Start by 
selecting the inside of the Wheel Collar and the outside of the 
Axle. You will see that only the Collar moves, this is normal. Use 
the Translate Handles to move the Collar onto the Axle .25 in.



Wheel & Axle

26 – Click OK and the Wheel will move onto the Axle. Double 
click on the Revolute Joint and use the Handle to test the 
Wheel rotation. Press Esc Key to finish testing the Wheel.



Gear & Axle

27 – Create a Rigid Joint between the Gear Locking Collar and 
the Axle by selecting the inside of the Collar and outside of the 
Axle. Use the Translate Handles to move the Collar onto the 
Axle .50”.

Note – In your physical assembly you will need Nylon Bushings
to fill the space between the Wheel/Gear and the Bushing.



Duplicate Wheel Assembly

28 – Select the seven components that make the Wheel 
Assembly. Start by clicking on the top component in the 
Browser, hold the Shift key and select the last component.
29 – Right click and choose Copy from the menu (Ctrl+C).



Duplicate Wheel Assembly

30 – Right click again and select Paste from the menu (Ctrl+V).
31 – Choose Point to Point in the Move/Copy Window.



Duplicate Wheel Assembly

32 – Select the Origin and Target Points. Start by selecting the 
fifth large hole on the top surface of the channel to set the 
Origin Point. Now select the fifth hole on the opposite end to 
set the Target Point. Click OK when finished.



As-Built Joints

33 – The Joints were lost in the copy and need to be restored 
but we don’t want any of the components to move from their 
current positions. To do this we need to use As-Built Joints. 
Select As-Built Joint from the Assemble Menu (Shift + J).



As-Built Joints

34 – Create Rigid Joints between the Collar and Wheel, Wheel 
Collar and Axle, Collar and Gear, Gear Collar and Axle, and both 
Bushings and the Frame. If Joint Type is not already set to Rigid 
then do so. Choose each component and use the Animate Tool 
to verify the correct Joint was created.



As-Built Joints

35 – Create a Revolute As-Built Joint between the Axle and 
Bushing. Change the Joint Type to Revolute and choose the 
Axle first followed by the Bushing. Set the Snap to the outside 
Bushing opening. Double click on the Revolute Joint and use 
the Rotation Handle to verify the correct Joint was created.



Add Wheels

36 – Using previous concepts, add the remaining two wheels 
and their appropriate Joints.



Gear Ratios

37 –Using the Magnifying Glass Icon on the Data Panel, search 
for ”Tetrix_39028” and ”Tetrix_39085”. Left click and drag one 
of each Gear into the workspace.



Gear Ratio

38 – Use the Move/Copy Tool to align the two Gears as shown 
below.



Gear Ratio

39 – Hide the Chassis by clicking the Hide Tool (eyes) to the left 
of the component description. Leave the two Gears visible.



Gear Ratio

40 – Create Points at the center of each Gear using the Point at 
Center of Circle/Sphere/Torus Tool under the Construct Menu. 
Select the tool and then each circle at the center of the Gears.



Gear Ratio

41 – Create Stub Shafts at the center of each Gear. To do this 
we need to create a Sketch. Select Create Sketch under the 
Create Menu. Choose the Surface you will be drawing on, in this 
case the face of the small Gear, and the Gears should move into 
position.



Gear Ratio

42 – Determine the diameter of the hole by using the Measure
Tool in the Inspect Menu. Select the Measure Tool and choose 
the hole in the small Gear. The Diameter will be shown in the 
Measure Window. Make note of the measurement and Close
the window.



Gear Ratio

43 – Using the diameter from step 42, create Circles on your 
Sketch at the center of the Gears. To do this select the Circle 
Tool in the Create Menu. Choose Center Diameter Circle. Select 
the center of the Circle and cursor over to the edge. The 
Diameter should appear or you can type in your measurement.



Gear Ratio

44 – Finish your sketch by choosing Finish Sketch in the Finish 
Sketch Menu. Now we can extrude the Stub Shaft using the 
Press/Pull Tool in the Modify Menu. Select the tool and the 
circle we sketched. Change Direction to Two Sides and set the 
Distance for Side 1 to .50” and Side 2 to .75”. Click OK.



Gear Ratio

45 – Rotate the Gears to view the Stub Shaft. Repeat the 
process for the Large Gear. Use the Home Icon in the View 
Cube to reset the workspace. 



Gear Ratio

46 – Create Revolute As-Built Joints between the Gears and the 
Stub Shafts. Choose the As-Built Joint Tool in the Assemble 
Menu and select the Small Gear first followed by its Stub Shaft. 
Change the Joint Type to Revolute and set the Snap to the 
center of the Stub Shaft. Repeat the process for the Large Gear.



Gear Ratio

47 – We need to link the motion of the two Gears. To do this,
select the Motion Link Tool in the Assemble Menu. Select the 
Joints for both Gears and set the relationship between them. 
We know the Small Gear has 40 Teeth and the Large Gear has 
120 Teeth. That means that the Small Gear has to turn 3 times 
for every rotation of the Larger Gear. Set the Angle of the 
second Revolute to 120 degrees (360 * 1/3) and select Reverse. 
Click OK when finished and use the Rotation Handle to test the 
Motion Link.





The following slides are from the first lesson our team learned. 
I’ve included them for reference only. Feel free to continue on.

These and the subsequent lessons are posted on our website, 
see the link below. I am NOT an expert by any means. I am only 
self taught so there are probably better teachers out there on 
YouTube and Google. You’ve been warned!

https://lindenrobotics.weebly.com/fusion360.html

lindenrobotics@gmail.com

Feel free to contact us with any questions and we’ll try to help 
find the answers. I can also provide the source files for what I 
put together if needed. Hopefully you weren’t too bored and 
thanks for checking us out!

https://lindenrobotics.weebly.com/fusion360.html
mailto:lindenrobotics@gmail.com?subject=Help!


Let’s draw our first SKETCH

1 – Click on Create.
2 – Choose Create Sketch.



Let’s draw our first SKETCH

There are 3 drawing planes – X, Y, & Z.

3 – Choose the XZ Plane by clicking on the box.

Y-Axis

Z-Axis

X-Axis



Let’s draw our first SKETCH

The drawing should spin to show the XZ plane looking down 
from above it.

4 – Draw a 2.5” X 2.5” rectangle with the bottom left corner at 
the origin.

Dimensions can be 
changed to inches or mm 
using Document Settings.

Select the Rectangle Tool.

Origin



Let’s draw our first SKETCH

5 – Type 2.50 in the dimension box and press the Tab key, type  
2.50 again in the other dimension box and press Enter.



Let’s draw our first SKETCH

6 – Select Finish Sketch from the Menu Bar. The image should 
spin back to the XYZ Planes as shown.



Let’s draw our first SKETCH

Let’s give the Square thickness.

7 – Choose Press Pull, click on Select, and choose the Square.

A - Select the Press Pull Tool.

B - Choose Select.

C - Click on the 
Square.



Let’s draw our first SKETCH

Let’s give the Square thickness.

7 – Grab the arrow and Pull upwards. You can now type in a 
thickness of 0.25 in and press Enter. You’ll see a solid square 
with ¼” thickness.



Let’s draw our first SKETCH

Let’s add 2 holes.

8 – Create a new Sketch and select the top surface of the square 
by clicking on it. It will highlight to indicate it’s selected. The 
drawing will spin so that you’re looking down on the surface.



Let’s draw our first SKETCH

Let’s add 2 holes.

9 – Lets add Construction Lines to locate the two holes we’re 
adding. Select the Line Tool. Drag the cursor across the top of 
the square until you see a Triangle (indicates the center). Click 
and drag it to the bottom edge keeping it at 90 degrees. Click 
again to end drawing the Line.



Let’s draw our first SKETCH

Let’s add 2 holes.

10 – Add another horizontal Construction Line to locate the two 
holes we’re adding. The Line Tool should still be active. Drag the 
cursor across the side of the square until you see a triangle 
(indicates the center). Click and drag it to the opposite edge 
keeping it at 180 degrees. Click again to end drawing the Line.



Let’s draw our first SKETCH

Let’s add 2 holes.

11 – We now need to offset the line above and below the 
centerline. Select the Offset Tool or press O. Click on the 
horizontal line and type in 0.75 in. The line will jump down (or up 
depending on axis) and press Enter. Repeat and enter -0.75 in.



Let’s draw our first SKETCH

Let’s add 2 holes.

12 – We now have Center Points for our holes. Draw two circles 
by using the Center Diameter Circle Tool. Select it and click on a 
Center Point we created. Drag the circle out and enter 0.50 in 
for the diameter. Repeat on the second center point.



Let’s draw our first SKETCH

Let’s add 2 holes.

13 – Delete the Construction Lines we created and finish the 
sketch. Click on each Line and press Delete. When done click on 
Finish Sketch.



Let’s draw our first SKETCH

Let’s add 2 holes.

14 – We can now Press Pull the circles through the part. Select 
both circles by holding the Shift key while clicking on them. 
Change the Operation to Cut and grab the arrow and drag the 
circles through the part. Press Enter and the holes will appear.



Let’s draw our first SKETCH

Let’s add a chamfer to the hole edges.

15 – Select both holes using the Shift key. Select the Chamfer 
Tool from the Modify Menu. Drag the arrow or type 0.10 in and 
press Enter.



Let’s draw our first SKETCH

Let’s add a fillet to the edges of the part for safety.

16 – Select all four top edges using the Shift key. Select the Fillet 
Tool from the Modify Menu. Drag the arrow or type 0.05 in and 
press Enter.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

17 – Create a new sketch and choose the top surface of the 
part. The drawing should spin and you should be looking down 
onto the surface. Add a Construction Line through the center of 
the part and offset it in both directions by 0.125 in. Delete the 
Construction Line and Finish Sketch.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

18 – Pull the surface you created out of the part. To do this 
select the rectangle contained between the two lines. Select the 
Press Pull Tool and drag the surface or type in 2.50 in. Make 
sure the Operation Type is set to Join.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

19 – Add a fillet to the inside edges of the new bracket. Select 
the edge and Fillet Tool and create a 0.10 in fillet. To get access 
to the back edge you can use the View Tool in the upper right 
corner of the screen. Your current view is shown by the 
darkened corner (Front Right in this case). Select the corner to 
the right and the drawing should rotate. Add a fillet to the other 
edge.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

20 – Now fillet the corners and add a hole in the center. Select 
both top corners and choose the Fillet Tool. Drag the arrow or 
type in 0.75 in.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

21 – To add the hole create a Sketch on the surface of the 
bracket. Draw Construction Lines 1.25 in down from the top and 
on center. Notice below my line went in the wrong direction. To 
fix this just double click on the 1.25” dimension and add a 
negative sign at the left of the number.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

22 – Add the circles using the Center Diameter Circle Tool. Draw 
the circle at the mid-point of the offset line shown by the 
triangle (39/64” = 0.609”). Finish Sketch and Press Pull the circle 
through the part.



Let’s draw our first SKETCH

Let’s add a mount to the bracket.

23 – Now add a 0.05 in fillet to the edges. To get to the small 
edges on the lower fillets you may need to Zoom in. You can do 
this using the Scroll Wheel on the mouse. Backwards zooms in 
and forwards pans out.



Let’s draw our first SKETCH

Next meeting we will make a new Component and add a Pivot
for motion.


